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AHB Advanced High Performance Bus FtERE S

APB Advanced Peripheral Bus R AN LR

BMC Bus Matrix Controller Sk A 1

DDR Double Data Rate Memory UG B o A7 s
DLM Data Local Memory s R A4 2%
DMAC Direct Memory Access Controller ELHE N AR [ 2 )
DSP Digital Signal Processor SRS E

GPIO General Purpose Input and Output | 3l FH % A4

12C Inter-Integrated Circuit Bus P S s L % e 2K

ILM Instruction Local Memory a2 R At %

ISA Instruction Set Architecture e |

LRU Least Recently Used I A Bl B 4 R
MCU Micro Controller Unit [pEatilE

PIT Programmable Interval Timer A 2 2 1 ol o I 2%
PLIC Platform Level Interrupt Controller | “F- & 2t 1] 2%
PLMT Platform Level Machine Timer & AL AUE I 2%
PMP Physical Memory Protection VI A AE DR

PWM Pulse Width Modulation Jik ot 5 A
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RISC-V Reduced Instruction Set Computer | & FLACK BT84 1HHE AL
A%

RTC Real Time Clock S B

SMU System Manage Unit ARG T TT

SOC System on Chip RS

SPI Serial Peripheral Interface AT AMEFE D

UART Universal Synchronous and I8 FH A0 R D ISR R
Asynchronous Receiver/Transmitter | 4 2%

WDT Watch Dog Timer BT V5E I 8

WFI Wait for Interrupt S AR v T nge R
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Mk www.gowinsemi.com.cn

E-mail: support@gowinsemi.com
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MR, 41545, |-Cache. D-Cache. ILM. DLM.
2R R AT IE S as AR A 25

BERAME R HE AHB BN APB 2840 . AHB B4 Ah
1% 64-bit Extended AHB Master. 32-bit Extended AHB Slave.
AHB2APB Bridge. APB & 4:4hixtudE 12C. PIT. SPl. UART1.
UART2. GPIO. WDT. RTC. SMU. DMAC. 32-bit Extended APB
Slave.
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3.1 WX ARG

PR &5 HE4H#A RiscV_AE350_SOC I & SHFIE -

3.1 A#%&RS

WAZ RS HIHRFE AN 3-1 PR .

® 3-1 WL ARGHHE
R4 FHIE
MCU Core 5-stage in-order execution pipeline

Frequency: Max. 800MHz

Hardware multiplier
radix-2/radix-4/radix-14/radix-256/fast

Hardware divider

Optional branch prediction

4-entry return address stack (RAS)

Static branch prediction

Dynamic branch prediction
32/64/128/256-entry branch target buffer (BTB)
256-entry branch history

8-bit global branch history

Machine mode, Supervisor mode and User mode

Optional performance monitors

Misaligned memory access

RISC-V physical memory protection

ISA

RISC-V RV32l base integer instruction set

RISC-V "C" standard extension for compressed instructions

RISC-V "M" standard extension for integer multiplication and
division

RISC-V "A" standard extension for atomic instructions

SUG1031-1.0
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RISC-V "N" standard extension for user-level interrupt and
exception handling

RISC-V "F" and "D" standard extensions for single/double-
precision floating-point

DSP supported

Privilege

Machine, Supervisor and User privilege mode

Page-based virtual memory, supervisor mode and SV32 virtual
address translation scheme

128 number of shared Translation Lookaside Buffer (TLB) entries

8 number of instruction TLB entries

8 number of data TLB entries

16 number of support physical memory protection entries

Hardware performance monitors

Vectored PLIC extension

Hardware stack protection extension

Hardware performance throttling mechanism extension

Power
Management

Wait-for-interrupt (WFI) mode

Debug

RISC-V extend debug support

Number of breakpoints: 8

External JTAG debug transport module
JTAG: IEEE STD 1149.1 style 4-wire JTAG interface
Serial: 2-wire serial debug interface

PLIC

Configurable number of interrupts: 1-1023

Number of interrupt priorities: 15

Configurable number of targets: 1-16

Vectored interrupt extension

Support software interrupts

Support 16 user interrupts

PLMT

The RISC-V architecture defines a machine timer that provides a
real time counter and generates timer interrupts

Cache

I-Cache

Size: 32KB

Associativity: 4-way
Replacement policy: pseudo-LRU

6(46)




3 RYURHLE

3.2 RS

RG AL

Soft error protection

: single/double error correction

D-Cache

Size: 32KB
Associativity: 4-way
Replacement policy
Soft error protection

: pseudo-LRU
: single/double error detection

Local Memory | ILM
Base: 0xA0000000
Size: 64KB

Soft error protection
detection

: single error correction and double error

DLM
Base: 0xA0200000
Size: 64KB

Soft error protection
detection

: single error correction and double error

Slave port support

3.2 Fiiksr RS

it s RGUAFE, W3R 3-2 Pr.

SUG1031-1.0

% 3-2 FhiERR R G

R4 AL

Instruction Memory | Address: 0x8

0000000~0x8FFFFFFF

Size: Max. 256MB

Bus: AHB bus interface

Embedded: SPI Flash Memory

Frequency: Max. 200MHz

Data Memory Address: 0x0

0000000~0x7FFFFFFF

Size: Max. 2GB

Bus: AHB bus interface

Embedded: DDR3 Memory

Frequency: Max. 200MHz
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SMU

SMU controls the flow of power and clock changes

UART1

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

UART2

The UART controller handles communications to the UART
interface.

Compatible with the 16C550A register structure
Support of the hardware flow control (CTS/RTS)
Support of hardware handshaking to the DMA controller
Option of by-8 or by-16 over-sampling frequency
Support of 64-entry transmit/receive FIFO depth

PIT

The PIT controller is a set of compact multi-function timers, which
can be used as PWM or simple timers. Each multi-function timer
provides the following 6 usage scenarios:

One 32-bit timer

Two 16-bit timers

Four 8-bit timers

One 16-bit PWM

One 16-bit timer and one 8-bit PWM
Two 8-bit timers and one 8-bit PWM

WDT

The WDT controller prevents the system from hanging if software is
trapped in a deadlock condition.

Internal/external clock source selection

Separate timers for the watchdog interrupt and the system reset
Eight choices of watchdog timer intervals

Four choices of reset timer intervals

Register write protection for watchdog timer control register and
restart register

Configurable magic number for register write protection

SUG1031-1.0

8(46)




3 RYURHLE

3.3 MAHMNBARG

SUG1031-1.0

/\é}E

AL

Configurable magic number to restart the watchdog timer

RTC

RTC keeps track of current time relative to a base time. The time is
stored in a RTC counter which records the amount of elapsed time
since RTC is enabled.

The frequency of clock source (before the clock divider) for the
counter is 32.768KHz

Separate second, minute, hour and day counters

Periodic interrupts: half-second, second, minute, hour and day
interrupts

Programmable alarm interrupt with specified second, minute and
hour values

GPIO

The GPIO controller supports up to 32 channels with independently
programmable input/output control.

Support of up to 32 GPIO channels
Independent control of each channel
Programmabile 1/O direction

Optional pull-up/down control

Optional support of interrupt trigger control

Flexible combination of interrupt trigger modes: high/low level
trigger and rising/falling/both edge trigger

Optional de-bounce functionality for input channels

12C

The 12C controller handles communications to 12C interface.
Programmable to be either a master or a slave device
Programmable clock/data timing

Support of the 12C-bus Standard-mode (100 kb/s), Fast-mode (400
kb/s) and Fast-mode plus (1 Mb/s)

Support of hardware handshaking to the DMA controller

Support of the master-transmit, master-receive, slave-transmit and
slave-receive modes

Support of the multi-master mode
Support of 7-bit and 10-bit addressing modes
Support of general call addressing mode

Support of auto clock stretch

SPI

The SPI controller handles communications to the SPI. The
supported serial data formats range from 4 bits to 32 bits in length.

Compliant with AMBA 2 AHB protocol specification
Compliant with AMBA 3 APB protocol specification
Support of MSB/LSB first transfer

Support of DMA data transfer

9(46)
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Support of programmable SP1 SCLK

Support of memory-mapped access (read-only) through AHB bus or
EILM bus

Support of SPI slave mode

Quad I/O SPI interfaces

TX/RX FIFO depth is128

Programming port location on APB interfaces

DMAC

The DMAC enhances system performance by transferring large
data blocks between devices in background to offload the
processor.

Compliant with AMBA AXI4 and APB4
Support of up to 8 DMA channels

Support of up to 16 DMA request/acknowledge pairs for hardware
handshake, 7 internal used, 8 for user

Support of up to two AXI master ports for data transfers
Support of up to two configurable DMA cores

Support of an APB slave port for DMA register programming
Support of 24—64 bits AXI address width

Support of 32/64/128/256 bits AXI data width

Support of narrow transfers on the AXI bus

Support of group round-robin arbitration scheme with 2 priority
levels

Support of chain transfers

Extended
APB Slave

For user to extend APB interface peripherals.
32-bit data bit width

Size: 64MB

AE350 is as master

Extended
AHB Slave

For user to extend AHB interface peripherals.
32-bit data bit width

Size: 128MB

AE350 is as master

Extended
AHB Master

For slave port support, assess local memory via master.
64-bit data bit width
AE350 is as slave

10(46)
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B
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4:3%2331&%
4.1 RGET4

RiscV_AE350 SOC I R4Gth %, 13k 4-1 P,

& 4-1 RYRTHh
ARG IR ik
PIAZ IS ol Max. 800MHz RISC-V Py#%Hh
DDR 4 Max. 200MHz HARAL AR B
AHB Frf 4 Max. 200MHz AHB 2RI BRI 48 & 17 i
2R I
APB I} £ Max. 200MHz APB 1 51 b
RTC i 32.768KHz RTC It 4
!

® NiZWI4h. DDR W%, AHB/APB W4, =3 [A]N 5w eh
® AHB 405 APB WH4f, —F 2 a4 1:1 [FE

4.2 HNTERTEh

RiscV_AE350_SOC ] Embedded Data Memory (DDR3 Memory)
I Bh, Nk 4-2 PR

= 4-2 NTERT
A7 B I e A g
DDR3_MEMORY_CLK 400MHz Fi P4\ DDR3 S0RL T A i 4
DDR3_CLK_IN 50MHz DDR3 S 4 A 4

4.3 tEEFRER

RiscV_AE350_SOC #1325 Dhrystone. CoreMark #fl
Whetstone Wl & 114 g 46 Hr, 05K 4-3 Fiw.
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4.3 TERERIR

4 ZGiTtRe
% 4-3 MEREIRHR
F AN TP PERESR IR
Dhrystone 1.72 DMIPS/MHz
CoreMark 3.224841 CoreMark/MHz
Whetstone 0.783 MWIPS/MHz
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RiscV_AE350_SOC [ &G, Wi#k 5-1 fiz.

+® 51 RZGeiw 0
e /0 hrge | ik JiTl&
RESET_N input | 1 System reset -
CORE_CLK input | 1 Core clock -
DDR_CLK input | 1 Data memory clock -
AHB_CLK input | 1 AHB or instruction -
memory clock
APB_CLK input |1 APB clock -
RTC_CLK input |1 RTC clock RTC
TCK_IN input |1 JTAG clock Debug
TMS_IN input | 1 JTAG tms Subsystem
TRST_IN input |1 JTAG trst
TDL_IN input | 1 JTAG tdi
TDO_OUT output | 1 JTAG tdo
TDO_OE output | 1 JTAG tdo oe
FLASH_SPI_CSN inout |1 Flash chip select n Embedded
FLASH_SPI_MISO inout | 1 Flash master in and Instruction
slave out Memory
FLASH_SPI_MOSI inout |1 Flash master out and
slave in
FLASH_SPI_CLK inout | 1 Flash clock
FLASH_SPI_HOLDN inout |1 Flash hold n
FLASH_SPI_WPN inout |1 Flash write protection
n
FR_PCLK input |1 Flash register APB Embedded
clock Instruction

13(46)
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FR_PRESETN input |1 Flash register APB Memory and
reset n Flash Register
FR_PADDR input | [31:0] | Flash register APB RW Mode
address
FR_PENABLE input |1 Flash register APB
enable
FR_PRDATA output | [31:0] | Flash register APB
read data
FR_PREADY output | 1 Flash register APB
ready out
FR_PSEL input |1 Flash register APB
select
FR_PWDATA input | [31:0] | Flash register APB
write data
FR_PWRITE input |1 Flash register APB
write enable
ROM_HADDR output | [31:0] | ROM AHB address Extended
ROM_HRDATA input | [31:0] | ROM AHB read data | Instruction
Memory
ROM_HREADY input | 1 ROM AHB ready in
ROM_HRESP input |1 ROM AHB response
ROM_HTRANS output | [1:0] | ROM AHB
transmission type
ROM_HWRITE output | 1 ROM AHB write enable
ROM_HCLK output | 1 ROM AHB clock
ROM_HRSTN output | 1 ROM AHB reset n
DDR3_MEMORY_CLK | input | 1 DDR3 memory clock Embedded
DDR3_CLK_IN input | 1 DDR3 input clock Data Memory
DDR3_LOCK input | 1 DDR3 lock
DDR3_STOP output | 1 DDRa3 stop
DDR3_INIT output | 1 DDRa initialized flag
DDR3_BANK output | [2:0] | DDR3 bank address
DDR3_RAS_N output | 1 DDR3 row address
select
DDR3_CAS_N output | 1 DDR3 column address
select
DDR3_WE_N output | 1 DDR3 write enable

14(46)
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DDR3_CK output | 1 DDR3 clock
DDR3 CK N output | 1 DDRa3 clock differential
DDR3_CKE output | 1 DDRa3 clock enable
DDR3_RESET_N output | 1 DDRa3 reset
DDR3_ODT output | 1 DDR3 on-die

termination
DDR3_ADDR output | [13:0] | DDR3 address
DDR3 DM output | [1:0] | DDR3 data mask
DDR3_DQ inout | [15:0] | DDRS3 data
DDR3_DQS inout | [1:0] | DDRS3 data select
DDR3_DQS_N inout | [1:0] | DDRS3 data select

differential
DDR_HADDR output | [31:0] | DDR AHB address Extended
DDR_HBURST output | [2:0] | DDR AHB burst Data Memory
DDR_HPROT output | [3:0] | DDR AHB protection
DDR_HRDATA input | [63:0] | DDR AHB read data
DDR_HREADY input | 1 DDR AHB ready in
DDR_HRESP input |1 DDR AHB response
DDR_HSIZE output | [2:0] | DDR AHB size
DDR_HTRANS output | [1:0] | DDRAHB

transmission type
DDR_HWDATA output | [63:0] | DDR AHB write data
DDR_HWRITE output | 1 DDR AHB write enable
DDR_HCLK output | 1 DDR AHB clock
DDR_HRSTN output | 1 DDR AHB reset n
EXT_INT input | [15:0] | Extended interrupts PLIC
APB_PADDR output | [31:0] | APB slave address Extended APB
APB_PENABLE output | 1 APB slave enable slave
APB_PRDATA input | [31:0] | APB slave read data
APB_PREADY input |1 APB slave ready in
APB_PSEL output | 1 APB slave select
APB_PWDATA output | [31:0] | APB slave write data
APB_PWRITE output | 1 APB slave write enable
APB_PSLVERR input |1 APB slave error
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response
APB_PPROT output | [2:0] | APB slave protection
APB_PSTRB output | [3:0] | APB slave write strobe
APB_PCLK output | 1 APB slave clock
APB_PRSTN output | 1 APB slave reset n
EXTS _HRDATA input | [31:0] | AHB slave read data Extended AHB
EXTS_HREADYIN input | 1 AHB slave ready in slave
EXTS_HRESP input | 1 AHB slave response
EXTS HADDR output | [31:0] | AHB slave address
EXTS_HBURST output | [2:0] | AHB slave burst
EXTS_HPROT output | [3:0] | AHB slave protection
EXTS_HSEL output | 1 AHB slave select
EXTS_HSIZE output | [2:0] | AHB slave size
EXTS_HTRANS output | [1:0] | AHB slave

transmission type
EXTS_HWDATA output | [31:0] | AHB slave write data
EXTS_HWRITE output | 1 AHB slave write

enable
EXTS_HCLK output | 1 AHB slave clock
EXTS_HRSTN output | 1 AHB slave reset n
EXTM_HADDR input | [31:0] | AHB master address Extended AHB
EXTM_HBURST input | [2:0] | AHB master burst master
EXTM_HPROT input | [3:0] | AHB master protection
EXTM_HREADY input |1 AHB master ready in
EXTM_HSEL input |1 AHB master select
EXTM_HSIZE input | [2:0] | AHB master size
EXTM_HTRANS input | [1:0] | AHB master

transmission type
EXTM_HWDATA input | [63:0] | AHB master write data
EXTM_HWRITE input |1 AHB master write

enable
EXTM_HRDATA output | [63:0] | AHB master read data
EXTM_HREADYOUT | output | 1 AHB master ready out
EXTM_HRESP output | 1 AHB master response
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DMA_REQ input | [7:0] | DMA requests DMA
DMA_ACK output | [7:0] | DMA acknowledges
SPI_HOLDN_IN input |1 SPl hold nin SPIl and none
SPI_WPN_IN input | 1 SPI write protection n /O ports
in
SPI_CLK_IN input |1 SPI clock in
SPI_CSN_IN input |1 SPI chip select nin
SPI_MISO_IN input |1 SPI miso in
SPI_MOSI_IN input |1 SPI mosi in
SPI_HOLDN_OUT output | 1 SPI hold n out
SPI_HOLDN_OE output | 1 SPI hold n oe
SPI_WPN_OUT output | 1 SPI write protection n
out
SPI_WPN_OE output | 1 SPI write protection n
oe
SPI_CLK_OUT output | 1 SPI clock out
SPI_CLK_OE output | 1 SPI clock oe
SPI_CSN_OUT output | 1 SPI chip select n out
SPI_CSN_OE output | 1 SPI chip select n oe
SPI_MISO_OUT output | 1 SPI miso out
SPI_MISO_OE output | 1 SPI miso oe
SPI_MOSI_OUT output | 1 SPI mosi out
SPI_MOSI_OE output | 1 SPI mosi oe
SPI_HOLDN inout |1 SPI hold n SPland I/O
SPI_WPN inout | 1 SPI write protection n | POrts
SPI_CLK inout | 1 SPI clock
SPI_CSN inout | 1 SPI chip select n
SPI_MISO inout |1 SPI master in and
slave out
SPI_MOSI inout | 1 SPI master out and
slave in
12C_SCL_IN input | 1 I2C clock in I2C and none
I2C_SDA_IN input | 1 12C data in /O ports
12C_SCL_OUT output | 1 12C clock out

17(46)




5 &%t K

SUG1031-1.0

HHK /0 hrgs | fik It
12C_SDA_OUT output | 1 I12C data out
I2C_SCL inout | 1 12C clock I2C and I/O
I2C_SDA inout | 1 I2C data ports
UART1_TXD output | 1 UART1 transmits data | UART1
UART1_RTSN output | 1 UART1 rts n
UART1_RXD input |1 UART1 receives data
UART1_CTSN input | 1 UART1 cts n
UART1_DSRN input | 1 UART1 dsrn
UART1_DCDN input | 1 UART1 dcd n
UART1_RIN input | 1 UART1 rin
UART1_DTRN output | 1 UART1 dtrn
UART1_OUT1N output | 1 UART1 out1 n
UART1_OUT2N output | 1 UART1 out2 n
UART2_TXD output | 1 UART2 transmits data | UART2
UART2_RTSN output | 1 UART2 rts n
UART2_RXD input |1 UART2 receives data
UART2_CTSN input |1 UART2 cts n
UART2_DSRN input | 1 UART2 dsrn
UART2_DCDN input | 1 UART2 dcd n
UART2_RIN input |1 UART2 rin
UART2_DTRN output | 1 UART2 dtr n
UART2_OUT1IN output | 1 UART2 out1 n
UART2_OUT2N output | 1 UART2 out2 n
CHO_PWM output | 1 PWM channel 0 output | PWM
CHO_PWMOE output | 1 PWM channel 0 output

enable
CH1_PWM output | 1 PWM channel 1 output
CH1_PWMOE output | 1 PWM channel 1 output

enable
CH2_PWM output | 1 PWM channel 2 output
CH2_PWMOE output | 1 PWM channel 2 output

enable
CH3_PWM output | 1 PWM channel 3 output
CH3_PWMOE output | 1 PWM channel 3 output
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E /0 hrgs | fik Jit)&
enable

GPIO_IN input | [31:0] | GPIO in GPIO and
GPIO_OE output | [31:0] | GPIO output enable none 1/O ports
GPIO_OUT output | [31:0] | GPIO output
GPIO inout | [31:0] | GPIO GPIO and I/0

ports
COREO_WFI_MODE output | 1 Core WFI mode status | SMU
RTC_WAKEUP output | 1 RTC wakeup status
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(P

RiscV_AE350_SOC RS E, W% 6-1 iz,

* 6-1 RGEE
i £ 16 100 7NN Y 1
Enable Extended Interrupts | <41 THIEYFERT 16 IR PS5
Embedded Instruction AV RANE TR A 7f#4: SPIFlash
Memory Memory
Flash Register R'W Mode | 5} JFJ5 Flash 27 #7228 B0 APB sl 4%

|

Extended Instruction K RO RN BEIR A ias
Memory
Embedded Data Memory Fa RGN BRI 74 DDR3 Memory
Extended Data Memory KA ROV RN EHAR A
Enable Extended AHB SNl TR 3 21 32-bit AHB Slave #11,
Slave AE350 /£ Master
Enable Extended AHB SNl TR 3 21 64-bit AHB Master #2211,
Master AE350 {E 4 Slave %%
Enable Extended DMAC K] FFIEH R 8 4 DMA 1 R/N &5
Enable 12C KM JHE 12C
Enable 12C 1/O Ports Ha FFJE 12C “INOUT” A5 [
Enable PIT x M FE PIT
PWM Channel 0 K FF 5 PWM i 0
PWM Channel 1 K 5 PWM i 1
PWM Channel 2 KM 5 PWM j@iE 2
PWM Channel 3 KM JFJE PWM j@iE 3
Enable SPI K JFE SPI
Enable SPI I/O Ports THA JFJE SPI “INOUT” 2 11
Enable UART1 K A UART1
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e 5 32 T3 NN Yi ]

Enable UART2 el )3 UART2

Enable GPIO Pl )5 GPIO

Enable GPIO I/O Ports FFE T8 GPIO “INOUT” Ak
Enable WDT el JFiE WDT

Enable RTC VAR JFiE RTC

Enable SMU K 5 SMU

Enable Extended APB el TFEY &K 32-bit APB Slave %11,

Slave

AE350 1E°4 Master
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7 WitinAE 7.1 TEAEHR

Rt R
7.1 B

® DK-START-GW5AT138 V2.0
-  GW5AST-LV138FPG676AES
- GW5AST-138B

7.2 B A

AR A . =R AT Gowin_V1.9.9 Beta-3.

7.3 ®IHRE

RiscV_AE350_SOC IP & il¥ifs, W pns:

1. SRRSO IP ¥t T B “IP Core Generator”, Ft&
RiscV_AE350_SOC IP #17, 7/ RiscV_AE350_SOC IP #it

2. mUREAR IP ¥t T A “IP Core Generator”, fit & PLL_ADV IP ik
T, 7742 PLL_ADV IP i&it, N RiscV_AE350 SOC IP #Atit 4 %
Y

3. M, s2fiik RiscV_AE350 _SOC IP, s:filtk, PLL_ADV IP,
NFABH BT, RSB e B TR R T

4. SRFTRFFRMG INPIELZIR, AT UME = I8 A R 208 T A

“FloorPlanner”;

5. SIPPER RF A HHR S, DR L, LU UK I 2
T.H “Timing Constraints Editor”;

6. ACELZAEILIN. A fRAn 2k UN AL IRTIE I

7. mEBAMR%GE TR “GowinSynthesis®”, 4:4 RiscV_AE350 SOC
AR, PR AR ST

8. ZURHMEMIATRATZ T. A “Place & Route”, A Jafi &M &k, 724
B A
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9. =IRHMAM FE L E “Programmer”, F#HEASIR S
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8 TEAH it TT ik 8.1 WL THE

81¥2H1i§ti+7’5525
8.1 By T2

$E1

WA ATH =R, % L8 “File > New... > FPGA Design
Project”, (T HA2 “L1”, 5 Quick Start “New Project...”, #d “OK”,
e 8-1 Fim o

8-1 New Project

9 -8 %
DEEE & i
Recent Projects:
Quick Start
== E= E=
W New ? x
N

v Projects
Teol 2% FPGA Design Project

| |Create a FPGA design project. L
You will be able to add or create RTL sources, run synthesis,
place & route, and program your device.

! Cance

Start Page [x]

B2
WE TRV TS, Bidi “Next”, WKl 8-2 frr.
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[&] 8-2 Project Name

W Project Wizard X

Project Name
E» Project Name
Select Device Enter a name for your project, and specify a directory where the project will be stored. The directory will be

. created if it doesn't exist.
Summary

MName: |ae$50_demo |

Create in: |C:\Users\\iukai\Desktop |

[] Use as default project location

ext = Cancel

H5% 3

WHEBMHEE, 45 Series. Device. Device Version. Package-
Speed #1 Part Number, .7 “Next”, #1 8-3 Fizn.

1 -

Series: GWSAST

Device: GW5AST-138

Device Version: B

Package: FCPBGAG76A

Speed: ES

Part Number: GW5AST-LV138FPG676AES
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8.2 IP #it

& 8-3 Select Device

W Project Wizard x

Select Device
Project Name

E» Select Device Specify a target device for your project
Summary Filter
Series: GWSAST ¥ | Package: |FCPBGAB76A -
Device: GWSAST-138 v | Speed: ES -
Device Version: B -

#no version number is initial version

Part Number Device Device Version Package Speed  Voltage

(GWSAST-LV138FPGG76AES |awsast13s |8 [Fcpeaacres

= Back ext = Cancel

=

i
e ARG, By “Finish”, WK 8-4 Fis.
8-4 Summary

W Project Wizard X

Summary
Project Name

Select Device Project
Eb STy N?me: ae358_demo . .
Directory: C:\Users\liukai\Desktop
Source Directory: C:\Users\liukai\Desktop\ae35@_demo\src
Implementation Directory: C:WUsersi\liukai\Desktop\ae358_demoiimpl

Device
Part Number: GWSAST-LV13BFPGE7BAES
Series: GWSAST
Device: GWSAST-138B
Package: FCPBGAGTBA
Speed: ES

= Back Cancel

8.2 IP it

SUG1031-1.0

TIREAER IP &1t T2 “IP Core Generator”, &
RiscV_AE350_SOC #%%, /£ RiscV_AE350_SOC IP.

IR PRS2 “Tools > IP Core Generator”, B¢ T E.#*
“d87”, $T7F IP Core Generator, %+ “Soft IP Core > Microprocessor
System > Hard-Core-MCU > RiscV AE350 SOC 1.0”7, #/& 8-5 7.
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SUG1031-1.0

& 8-5 IP Core Generator

{7 GOWIN FPGA Designer - [IP Core Generator] - m] X
l& Hle Edit Project Tools Window Help _la x
—. e an o
=]~ el Y 1Y X
oo 2% g e [sasrsorcsrses | ]
~ [ ae350_demo - [C\Users\|iu... Filter ‘ ~
[E] cwsasT-Lvi38rPGe76AES = .
N Vers
o - RiscV AE350 SOC
> User Flash
v Soft IP Core R
> A Information
5> [ BackGround Configuration
> DSP and Mathematics. Type: RiscV AE350 SOC
’ Interface and Interconnect Vendor: GOWIN Semiconductor
> Memory Control
v | Microprocessor System
> Bus bridge Summary
~ [ Hard-Core-MCU
& Gowin EMPU(GW1NS-4C) RiscV AE350 S0C platform integrates A25 Core, a 32bit CPU base on
b RiscV AE350 SOC 10 RISC-V. There are UARTO, UART1, SPI, I2C, PIT, GPIO, DMAC, WDT,
> Soft-Core-MCU RTC and SMU peripherals integrated in this platform. Extended AHB
> Multimedia slave and APB slave can be used by user to define their own SOC
> Serdes © system. Extended AHB master can be used by user to use AE350 as
< > a slave device. v
Design  Process  Hierarchy L Start Page a Design Summary 8 & IP Core Generator [x]
Console 8 x
%
Console  Message

Mt “RiscV AE350 SOC 1.0”7, FTJT RiscV_AE350_SOC IP Core,

ﬁ[] @ 8'6 FEZT_\‘ o
& 8-6 RiscV_AE350 SOC IP Core

W RiscV AE350 50C

General

Device: [GwsasT-138
Part Number: | GWSAST-LV138FPG676AES |

| Device Version: |B |

Create In: ‘ Ch\Users\liukaiDesktoplae350 demo'\src\riscv_ae350 soc | EI
File Name: riscv_ae350_soc Module Name: RiscV_AE350 SOC Top
Language: ‘Verilog -
~
AE350Subsystem

27(46)




8 TEAN Bt T5 ik 8.2 IP #il

RiscV_AE350_SOC "L & [ &4 e tw#E PLIC. Instruction
Memory. Data Memory. 12C. PIT. SPI. UART1. UART2. GPIO.
WDT. RTC. SMU. DMAC. Extended APB Slave. Extended AHB Slave
F1 Extended AHB Master, Bt B EDianE 6-1 Frifid.

PUR 2 W PR B R D REATIE T AC & 7 1%
8.2.1 PLIC

T 9F PLIC, FLE PLIC #35, W&l 8-7 FioR.

k% FE “Enable Extended Interrupts”, MIFFEH I 16 Ao
WifEs, BRIAKH,
8-7 PLIC it B

" PLIC ? *

PLIC oo

meadule of RiscV AE350 SOC is for user level ~
extended interrupts, including configurable
RN interrupt trigger types, software programmable
cong ek interrupt generation, preemptive priority
interrupt extension and vectored interrupt
extension.
If users enable the extended interrupts, it
could expart 16 extended interrupt signals.

Option

Configuration

N EREEE

Enable Extended Interrupts

Rig ¢V AE3SD 50C

Cancel

8.2.2 Instruction Memory

XA ATHF “Instruction Memory”, L E 4817 i #FiLT, Wnfsl 8-8 fir

N

Instruction Memory £.4f Embedded Instruction Memory #l1 Extended
Instruction Memory. #1i%E# “Embedded Instruction Memory”, I J 3
Z YN B SPI Flash Memory; %k # “Extended Instruction
Memory”, JIFfE ROMAHB 411, HF BiTi& 1 AHB #2382 12
25

A48\ “Embedded Instruction Memory”, 13 £ 4N & 1 SPI
Flash Memory.

W I 5 Embedded Instruction Memory, IT] LARC# Flash Register
R/W Mode. #Ri%&+#F “Flash Register R'W Mode”, N5 Flash &7 17 &%
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HE APB k3% 11, Flash T UME NS, @it arfeasiss. 5 MRS
&, BRIAKIM .

[%] 8-8 Instruction Memory B &

& Instruction Memory ? x

Instruction Memory T

embedded memary as instruction memory. A
— Extended Instruction Memory exports all ROM
AHB bus signals for user level memory.

Embedded Instruction Memary is allowed to
access Flash with register maode, this is, users can
erase, read and write flash as a peripheral.

TITTTTITIVETINTY
PO S T T T T

Options
T K -
e -
— Instruction Memary Select
, (®) Embedded Instruction Memary
- - Flash Register R/W Mode
e (O Extended Instruction Memory v

Ruc SE2E0 SO

8.2.3 Data Memory

T “Data Memory”, BCEEiEFitast i, ik 8-9 Fris.

Data Memory fi35 Embedded Data Memory 11 Extended Data
Memory. WIHE%EH “Embedded Data Memory”, TIJTJE 248 N & )
DDR3 Memory; #n#i%k# “Extended Data Memory”, )5 DDR AHB
B, P EAT#T AHB £ O s 17 i 8%

Z4:EN “Embedded Data Memory”, J1/3 & 4: /N & i) DDR3
Memory.
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[# 8-9 Data Memory Bt &

o Data Memory ? *

Data Memory oo

SOC is for running MCLU data, including A
embedded data memory mode and extended
data memory made.

Embedded data memory is to configure
embedded memary as data memory. Extended
data memary exports all RAM AHB bus signals
for user level memory.

.......

L

Options

Configurations

Data Memory Select
(® Embedded Data Memory

S S S S S Y Y
EEREEEEREEREREEEE!

() Extended Data Memory v

Mucle AE IS0

8.2.4 12C

AT 12C, BCE 12C %55, 1k 8-10 Fis.
® NHiEHE “Enable 12C”7, NFFE 12C, BRi\EH
® WIEIFE 12C, MR AR E 12C i 1287

- WREE “Enable 12C 1/0 Ports”, NJFJE 12C “INOUT” 57 i
M, {UFE “INY, “OUT” 2285w, ERIA “INOUT” i 28

8-10 I2C E¢ B

ww 12C [ >

12C &

DAMC, -
The 12C module is a peripheral of APB bus

ReSET M interface in AE3530 SOC. If users enable 12C, it

could export |12C signals for user level.

- Base address: 0xFOAQQ00D
. . - End address: OxFOAFFFFF

Option

Configuration

2 sna - Enable 12C

bbb

T Interface:

Enable 12C IO Ports v

Ris €W AE3S0 SOC
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8.25 PIT
WFTIF PIT, BCE PIT &5, W& 8-11 k.
WnFEFE “Enable PIT”, MFFJE PIT, ERAKH
WARIFE PIT, WA LA E PWM JEiE
- WREFE “PWM Channel 07, NJFFJE PWM iliiE 0, BRilCH
- R EE “PWM Channel 17, MIFF3 PWM il 1, ERAKH
- R EFE “PWM Channel 27, MIFFj3 PWM iliE 2, ERAKH
- WREFE “PWM Channel 37, JFJE PWM iliiE 3, BRilCH
8-11 PIT BL &
2T ? *
S0 &
signals for user level, "
o - o addrons DOAFFIE. “
i e Opir
e u - PWM Channel Select 2
:: : PWM Channel 0
e L. PWM Channel 1
el o~ PWM Channel 2
— e PWM Channel 3
Cancel
8.2.6 SPI

XTI SPI, BCE SPI &, WK 8-12 Fix.
® ML “Enable SPI”, NFFiE SPI, ERiAJEH.
® NEFFJE SPI, NnLIACE SPI g 287,

- WRERE “Enable SPI1/0O Ports”, IFF)& SPI “INOUT” iy
O, B0 E “IN”, “OUT”. “OE” KAumH, BRiL “INOUT”
IRE
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[ 8-12 SPI Et &

44 5Pl ? X

SPI o

quad I/O maodes. ~
The SPI madule is a peripheral of APB bus

interface in AE350 SOC. If users enable SPI, it

could export SPI signals far user level.

- Base address: OxFOFQ0O000
- End address: OxFOFFFFFF

Option

Configuration

Enable SPI

bbby
I R B R R

o a1 Interface:

Enable SPI IO Ports v

Fis oW AL3S0 S0C

8.2.7 UART1 #1 UART2

i UART1 8 UART2, fit# UART1 8 UART2 &5, 4nf&l 8-13 fr

7INo

® Hik#E “Enable UART1”, NIJF/E UART1, ZRiIAKH .
® Hik#E “Enable UART2”, NIJF/E UART2, ZRiAKH .
8-13 UART1 #1 UART2 fii &

ww UART ? x

UART )

The UART module is a peripheral of APB bus  ~
— L. interface in AE350 SOC. If users enable UART1 or
:: UART2, it could export UART1 or UART2 signals
| - for user level.
—i =
o - UART1 UART2
= . - Base address: OxFO200000  OxFO300000
= | - End address: OxFO2FFFFF OxFO3FFFFF. W
= "
—] e |l o .
s ) Options
™ . . Ll
= Configuration
—* e
::" e Enable UART1
o |- Enable UART2

v
Bimcls' AF 350 200
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8.2.8 GPIO

Wi+ GPIO, ELE GPIO kT, Wikl 8-14 Fiis.
® [nfLik#¥ “Enable GPIO”, NJF5 GPIO, BRAKHI.
® AJT)F GPIO, NnILARLE GPIO i F2RAY:

- nE%EHE “Enable GPIO I/O Ports”, MFFf GPIO “INOUT” 247
ﬁﬂuﬁl:l, 7[59‘\]”9:':}% “IN”\ “OUT”\ “OE” %ﬂﬁﬁ”ﬁlﬂ, Ej(i/)\
“INOUT” i 12824
8-14 GPIO BL &

" GPIO 7 *

GPIO &

de-bounce functionality for input channels. A
The GPIO madule is a peripheral of APB bus

T interface in AE350 SOC. If users enable GPIC, it

could export GPIO signals for user level.

- Base address: OxFO700000
- End address: OxFO7FFFFF

Option

Configuration

Enable GPIO

Tt
}

Interface:

Enable GPIOQ I/O Ports v

Ris oW AL350 S0C

829 WDT

3T WDT, ECE WDT &5, K 8-15 s,
MR IES “Enable WDT”, MJFF/E WDT, ZRiIAKH].
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8.2 IP it

8.2.10 RTC

8.2.11 SMU

SUG1031-1.0

& 8-15 WDT EC. &

ww WDT

WDT

2

watchdog timer reaches zero. The timer should A
be restarted in the watchdog interrupt service
routine.

The WDT module is a peripheral of APE bus
interface in AE350 SOC.

-
—
—
s T - Base address: OxFOS00000
— s - End address: 0xFOSFFFFF
| aTC L v
—.{ T - Option
—n T S
i Configuration
— e o Enable WDT
WHATH RTC, Bl RTC &, 1kl 8-16 fis.
BNTF A RTC, An]kH.
[# 8-16 RTC BL &
e RTC 5 %

RTC

2

TOOCUT [

bh bbby

Rig ¢V AE3SD 50C

The RTC includes separate second/hour/day  ~
counters, periadic interrupts, and programmable
alarm interrupt with specified
second/minute/hour values.

The RTC module is a peripheral of APB bus
interface in AE350 SOC.

- Base address: OxFO600000
- End address: OxFOGFFFFF v

Option

Configuration

Enable RTC

Cancel

T SMU, BLE SMU &5, & 8-17 frr.
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R IES: “Enable SMU”, NITFE SMU, BRIAFEM] .
& 8-17 SMU E2&
o SMU ? b4

SMU

2

— T
i O AT .
— noacLe
-
g o
S prew
— e
CORED W AOE i
e T
e TS, (4
| B AT WACEIF -
— T
RiscW AE350 50C

of RiscV AE350 SOC controls the flow of power  »
and clock changes.

The SMU module is a peripheral of APB bus
interface in AE350 SOC. If users enable SMU, it
could export SMU signals for user level.

- Base address: 0xF0O100000
- End address: OxFO1FFFFF

Option

Configuration

Enable SMU

8.2.12 DMAC

SUG1031-1.0

XFFTIF DMAC, Fit® DMAC &5, & 8-18 .
IRk “Enable Extended DMAC”, NIJTF/E3 R 8 41 DMA iR/

NEAES, BRIAKH.
8-18 DMAC it B

&4 DMAC ? X
processar. ~
The DMAC supports up to 8 extended DMA
= channels and up to 16 DMA
— o request/acknowledge pairs for hardware
_— i . handshake.
e If users enable the extended DMAC, it could
export B extended DMA request/acknowledge
e pairs for user level.
—] s s e v
I Option
= ThE (N
I vssma = Configuration
— T
Y Enable Extended DMAC
Ris €V AE350 SOC
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8.2.13 Extended APB Slave

it 4T T Extended APB Slave, [t & Extended APB Slave £,

K] 8-19 7.

an

% “Enable Extended APB Slave”, MFE$ &K 32-bit APB

Slave #:11, ZRi\KEH.
8-19 Extended APB Slave fit &

'\ Extended APB Slave ? *
R
Extended APB Slave 31
P
- - Base address: 0xFE000000
e T QT e - End address: OxFEFFFFFF
e ) B - Size: 64MB
— 00 hd
——
= i H
Option
— i Bl P
— >
—_r R Configuration
— e Enable Extended APE Slave
—] S
— T
AT —_—
— DAA
—n 2 o R
— @ a
RiscV AE350 S0C

8.2.14 Extended AHB Slave

SUG1031-1.0

M7 T Extended AHB Slave, it & Extended AHB Slave %1,

<l 8-20 FiaR .

un

R IEFE “Enable Extended AHB Slave”, NF 24 &) 32-bit AHB

Slave #1171, ZRiAKH .
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[E 8-20 Extended AHB Slave fit &

w1 Extended AHB Slave 7 b

Extended AHB Slave 55-}4

bus interface. A
) If users enable the Extended AHB Slave, it
ST o0 o .
e could expart AHE slave bus signals for user
— OREC -
e level,
s TS, HADDRINY el
—H = ESTS HEIRSTIMY il - Base address: 0xES000000
] [ . - End address: OxEFFFFFFF
. Size: 128MB

— TN L2

EXTS HETER -
— s
S EATS HTRANGIE [l Option
| ENTS CAVDATAIILY e
—] 275 4a0gAR BT AT Configuration
—al a7 Ay AT RO

o Enable Extended AHB Slave
JE P — BT 3T |
RiseV AE350 50C

8.2.15 Extended AHB Master

X7 Extended AHB Master, fit & Extended AHB Master %&£,
ﬁﬂ@ 8'21 Fﬁﬂ—_‘—\‘o

Rk “Enable Extended AHB Master”, NH 54 & 1Y 64-bit AHB
Master 211, ERIARMA .

8-21 Extended AHB Master Bt &

' Extended AHB Master ? b4

Extended AHB Master &S

u
The Extended AHB Master module of RiscV
i AE350 SOC is a standard AHB bus interface. RiscV
:. - L AE350 S0C is as slave, user level side is as master.
. If users enable Extended AHB Master, it could
e export AHB master bus signals for user level.
2. e
]
== Option
— [ i .
e
I Configuration
ot .
::T Enable Extended AHE Master
.
R L 1-4

i#id It AHB Master #2110, AE350 24in] LIME N Slave, FPGA &4:1]
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PIME N Master, FPGA £4i1)jin] AE350 24t A 1 ILM A1 DLM, M &
T FPGA RS K125 ]

8.3 APt

8.3.1 RiscV_AE350_SOC IP it

IR R IP %21t T H “IP Core Generator”, 58/,
RiscV_AE350_SOC IP [t &5, H.ii “OK”, /%4 RiscV_AE350_SOC IP
wit, K 8-22 fs.

[ 8-22 RiscV_AE350 SOC IP &3t

(& RiscV AE350 SOC ? X

General

Device: |GW5AST-138 ‘ Device Version: |B |
Part Number: [GWSAST-LV138FPG676AES |

Create In: |C:\Users\liukai\Desktop\aeSSO_demo\src\riscv_aeSSO_soc |
File Name: riscv_ae350_soc Module Name: |RiscV_AE350 SOC Top
Language: Verilog -

AE350 Subsystem

I 1 [ 1

8.3.2 PLL_ADV IP &3t

AR IP %3t T B “IP Core Generator”, Fi & PLL_ADV IP i%
5, 74 PLL_ADV IP i, J9 RiscV_AE350 _SOC IP {ALif iz i .

E IR ARk “Tools > IP Core Generator”, B{ T H.4*
“d8”, 4Tt IP Core Generator, %+ “Hard Module > CLOCK >
PLL_ADV 1.0”7, %% 4-1 f1% 4-2 it & PLL_ADV IP, % PLL_ADV
IP & it, &l 8-23 fw.

. AT RiscV_AE350 SOC W1 PLL_ADV IP:
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ClkoutO: DDR clock

Clkout1: CORE clock

Clkout2: AHB clock

Clkout3: APB clock

Clkout4: RTC clock

FT RiscV_AE350_SOC DDR3 Memory ] PLL_ADV IP:
® Clkout0: DDR3 input clock

® Clkout2: DD3 memory clock

[¥] 8-23 PLL_ADV IP #&it

% IP Customization ? x
PLL o
5 T
General
Device: [awsasT-138 | Deviee version: |8 |
Part Number: | GWSAST-LV1 38FPGG7GAES | tanguage: Verilog -
File Name: | gowin_pll | Module Name: [ Gowin_PLL |
Create In: | C\Users\liukai\Desktop\gwSast\ae350_demalsrc\gowin_pll
- Common Clkoutd  Clkout!  Chou2  Cleout?  Clkoutd  ClkoutS  Clouts  Clkfbout
ll o -
— | enci e CLKIN PLL Reset "
— ] encikt | Clock Frequency(10~400): [50.000 |3 PLL Reset
P Divider Factor [] PLL Power Down
il =
— enctia Static |1 | (1~64) [] CLKIN Divider Reset
il =
N [ CLKOUT Divider Reset
e VCO Frequency:
T enchs CLKFB Lock
wis -
e b Source: @ Internal External Enable Lock
— i st lock [~ Divider Factor
Static |1
ICP and LPF Optional Ports
ICPSEL 55C
Static |ICP1 Clock Enable Ports
v

Cancel | | Calulte

® RiscV_AE350_SOC KNIt “PLL_R[0] > clkout1” ELEZAE, 2 4{#
PLL_ADV IP ] “clkout1” /=4 i 4.

® RiscV_AE350_SOC ) DDR3 Memory &l i “PLL_L[0] > clkout2” ELiEHRML, il
ffiF] PLL_ADV IP [f] “clkout2” 7*/: DDR3 Memory I} 4f,

8.3.3 A&t

BT E R b, szl RiscV_AE350 _SOC IP, szt
PLL_ADV IP, JIAFABF P88, R S gl il e B i 1351t
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8.4 AR

8.4.1 AR

Z IR R, IAERZA R, v DM = IR A B 2 R T A
“FloorPlanner”. =J#¥4:, EFF 32 “Tools > FloorPlanner”, BT H

*ll. & _0»
= o
— — o

#1127 ¥ i1t DK-START-GW5AT138 V2.0 DVK Board 5 AICE-MINI+
(K1 JTAG £ H IR MOIERTT 30, Ik 8-1 Fa.

% 8-1 LA JTAG YR

JTAG #:1 DVK Board AICE-MINI+
GND J3-8 P3

TMS J3-3 P4

TCK J3-4 P6

VREF (3.3V) J3-7 P7

TRST J3-5 P10

TDO J3-6 P11

TDI J60-3 P12

!

® RiscV_AE350_SOC KNI H “PLL_R[0] > clkout1” ELEHAE, WAL
PLL_ADV IP {1 &4 “PLL_R[0]”. %11, INS_LOC
"u_Gowin_PLL_AE350/PLL_inst" PLL_R[0].

® RiscV_AE350_SOC ) DDR3 Memory &l i “PLL_L[0] > clkout2” ELIEHRML, il
25k PLL_ADV IP (A2 & N “PLL_L[0]”. %140, INS_LOC
"u_Gowin_PLL_DDR3/PLL_inst" PLL_L[0]

8.4.2 BIFFAR

SRR F s, OB R, AT DU 2 IR A R B 249 3R
T.E. “Timing Constraints Editor”. =Jf#H M, EFF3EH “Tools >
Timing Constraints Editor”, & T HAZ “~ 7,

BAEN B ik, “Place & Route > Timing Analysis Report”, #in&
8'24 Fﬁ/j——;‘ o
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8.5 &

8.5 GL &

[¥] 8-24 Timing Analysis Report

{4 GOWIN FPGA Designer - [C\Users\liuka

1 | Design Summary
~ [, User Constraints
[1F FloarPlanner
#£ Timing Constraints Editor
v (D synthesize
Synthesis Report
Netlist File
~ (D Place & Route
Place & Route Report

Timing Analysis Report
Ports & Pins Report

™ .
1 Program Device

Design  Process  Hierarchy

Console

\Desktop\ae350_demo\impl\pnr\ae350_demo.tr.html]

|7 Elle Edit Project Tools Window Help
O
Process & x

Timing Messages
» Timing Summaries
STA Tool Run Summary
Clock Summary
Max Frequency Summary
Total Negative Slack Summanry
» Timing Details
» Path Slacks Table
Setup Paths Table
Hold Paths Table
Recovery Paths Table
Removal Paths Table

Mi

mum Pulse Width Table
» Timing Report By Analysis Ty|

v

Satun Analucic Ranart

< >

¢ Start Page

Design Summary b

W me -
WNUMDErs or Serup VIolared £napoines | U

Numbers of Hold Violated Endpoints | 0

Clock Summary:

T T

pll_clkout2

CLK
u_RiscV_AE350_SOC_Top/FLASH_SPI_CLK_iobuf/I
u_RiscV_AE350_SOC_Top/FLASH_SPI_CLK_in
u_Gowin_PLL/PLL_inst/CLKOUTO.default_gen_clk
u_Gowin_PLL/PLL_inst/CLKOUT1.default_gen_clk
u_Gowin_PLL/PLL_inst/CLKOUT3.default_gen_clk
u_Gowin_PLL/PLL_inst/CLKOUT4.default_gen_clk

Max Frequency Summary:

Al clladd

[ro  Cckvame o s i
: .
<

ae350_demo.trhtml

Base
Base
Base
Base
Generated
Generated
Generated

Generated

20.000
20.000
10.000
10.000
20.000
1.250

20.000
100.00

=0 NAAMMLZ

[x]

50.000
50.000
100.000
100.000
50.000
800.000
50.000
0 10.000

sn n7aMEY

14

(
(
«

>

[95%] Timing analysis completed
Placement and routing completed
Bitstream generation in progress
Bitstream generation completed

Generate file "C:illsers\1iukai\Desktonlae3sa demodimnlinnriaeiSA demo.nin.html™ comnleted
<

%

Console | Message

8.5.1 Z&IXIN

SUG1031-1.0

“Synthesize > General” Zx &L WAL E, 1 8-25 fr. -

i

T Z IR T B SEBRk S5 4%, BCE Include Path
Verilog Language A&, {541 System Verilog 2017

SR SL PR T E B 4 FR, BCE Top Module/Entity
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& 8-25 {ZR XA E

A7 Configuration X
Synthesize
v Global General
Voltage Synthesis Toal: (®) GowinSynthesis

v Synthesi :
yninesize Top Meodule/Entity: |an3350_demo_top |

General
v Place & Route Include Path: | |
General TelPre | |
Place
Route GowinSynthesis
Dual-Purpose Pin Verilog Language: | System Verilog 2017 ~
Unused Pin -
v EBitStream Looplimit: 2000 =
General [ show All Warnings
sysControl [] Disable Insert Pad

Feature sysControl

Ram R/W Check

Cancel Apply

8.5.2 TR

i AT RIETC &, L35 General. Place. Route. Dual-Purpose Pin
Al Unused Pin, 1l 8-26 s .

S T ) SEBR 75 SR AL &, 4140 Dual-Purpose Pin &5, & H
“SSPI1”, “MSPI” 1 “CPU” ~¥iHE 10,

& 8-26 i B L& E AL 2

G Configuration X

Dual-Purpose Pin

v
Global [] Use JTAG as regular 10

Voltage

v &ynthesize Use S5PI as regular 10

Use MSPI as regular 10

General

v Place & Route [] Use READY as regular 10
General [] Use DONE as regular 10
S:LT; [] Use RECONFIG N as regular 10

Dual-Purpose Pin Use 12C as regular 10

Unused Pin Use CPU as regular 10
v BitStream

General

sysControl

Feature sysControl

Cancel Apply
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o
o
I
op

8.5.3 F&iIiLIN

8.6 ZRE

SUG1031-1.0

IR L A & 145 General. sysControl #1 Feature sysControl, %1/

8-27 Fli7N .
8-27 ISRIENACE

W Configuration

BitStream

v Global Enable CRC Check

Voltage

v Synthesize [ Enable Compress

General [ Enable Encryption
v Place & Route Key(Hex):
General Enable Security Bit
Place
Secure Mode

Route

Dual-Purpose Pin Power On Reset Monitor
Unused Pin Print BSRAM Initial Value

v BitStream Bitstream Format: Text ¥
General
sysControl

Feature sysControl

Cancel Apply

=B 44 T A “GowinSynthesis®”,

BEPF B, AR, G 8-28 k.
[ 8-28 &7 4

Zi& RiscV_AE350_SOC

GOWIN FPGA Designer - [C:\Users\liukai\Desk

p\ae350_demotimpl 50_dema_syn.rpthtml]

[ Ele Edit Project Iools Window Help

DEEE i) 5% &

Process & X

1 | Design Summary

—— Synthesis Messages
v [ User Constraints 4 9 Top Level Module

Synthesis Details

£ FloorPlanner

7 Timing Constraints Editor Resource

v (D) synthesize
Synthesis Report

+ Resource Usage Summary

+ Resource Utilization Summary
Timing

« Clock Summary

Netlist File

v Place & Route

Place & Route Report o Max Frequency Summary

Timing Analysis Report < Detail Timing Paths Informations
Ports & Pins Report

u .
1i# Program Device

Synthesis Process

Design  Process  Hierarchy v Start Page Design Summary

Console

Synthesis Details "

3e350_demo_top

Running parser:

CPU time = 0h Om 1s, Elapsed time = 0h Om 15,
Peak memory usage = 100.953MB
Running netlist conversion:

CPU time = 0h Om 0s, Elapsed time = 0h Om 0s,
Peak memory usage = OMB
Running device independent optimization:

Optimizing Phase 0: CPU time = Oh Om 0.031s,
Elapsed time = Oh Om 0.048s, Peak memory usage =
100.953MB

Optimizing Phase 1: CPU time = Oh Om 0.046s,
Elapsed time = Oh Om 0.023s, Peak memory usage =
100.953MB

Optimizing Phase 2: CPU time = Oh Om 0.031s,
Elapsed time = Oh 0m 0.028s, Peak memory usage =
100.953MB
Running inference:

Inferring Phase 0: CPU time = Oh Om 0.046s,
Elapsed time = 0h Om 0.054s, Peak memory usage =
100.953MB

Inferring Phase 1: CPU time = Oh Om Os, Elapsed
time = Oh Om 0s, Peak memory usage = 100.953MB

Inferring Phase 2: CPU time = Oh Om 0.015s,
Elapsed time = Oh Om 0.007s, Peak memory usage = ©

ae350 demo_syn.rpthtml ]

8 x

[95%] Timing analysis completed

Placement and routing completed

Bitstream generation in progress......

Bitstream generation completed

Generate file "C:\llsers\liukai\Deskton\ae3SA demo\imnl\nnr\aei5@ demn.nin.html” comnleted
<

%

Consale  Message
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8.7 ARtk

8.7 Ttk

ZVREBAE AT AT 2k T H “Place & Route”, i i Ai & M S0k, 724
oSk, ik 8-29 s,

8-29 H Efhzk

{4y GOWIN FPGA Designer - [C:\Users\liukai\Desktop\ae350_demo\impl\pnriae350_demo.rpthtml] - 0 x
7 Ele Edit Project Tools Window Help SILAE
S B 5g g - Ll
[ PR de St st Y| O e«
. &
Process 8 x PnR Details

{ | Design Summary

vBRu . PnR Messages Running placement:
i User Constraints P t Phase 0: CPU time = 0h Om 0.363s, Elapsed time = 0h 0m 0.363
PnR Details acement Phase 0: ime m 0.363s, Elapsed time m 0.3635
7| FloorPlanner n Placement Phase 1: CPU time = 0h Om 0.191s, Elapsed time = 0h Om 0.19s

Placement Phase 2: CPU time = Oh Om 0.161s, Elapsed time = Oh Om 0.162s

7% Timing Constraints Editor Resource P\ace‘m‘ent Phase 3: CPU time ; 0h om 15|, Elapdse_d time ; 0h Om 1s
. Q Syrtbesize Resource Usage Summary RJ:rSﬁwgpriieth'jt‘ CPU time = 0h Om 2s, Elapsed time = 0h Om 2s
) 1/0 Bank Us@ggéﬁf{,’ﬁ%ﬁ\".ﬂcgss Routing Phase 0: CPU time = Oh Om 0.588s, Elapsed time = 0h 0m 0.588s
Synthesis Report Routing Phase 1: CPU time = Oh Om 6s, Elapsed time = Oh Om &6s
- Global Clock Usage Summary Routing Phase 2: CPU time = Oh Om 0.43s, Elapsed time = Oh Om 0.43s
Netlist File Routing Phase 3: CPU time = Oh Om 0s, Elapsed time = 0h Om 0s
7 Global Clock Signals Total Routing: CPU time = 0h Om 7s, Elapsed time = 0h Om 7s
v () Place & Route i b Generate output files:
= Place & Route Report Pinout by Port Name CPU time = 0h Om 18s, Elapsed time = 0h Om 185

Timing Analysis Report All Package Fistal Time and Memory Usage | CPU time = Oh Om 27s, Elapsed time = 0h Om 27s, Peak memory usage = 972MB
Ports & Pins Report

o )
[ Program Device

Resource

Design  Process  Hierarchy , Start Page Design Summary ! ae350_demo.rpt.himl

Console 8 X

Generate file "C:\User‘5\1iukai\Desktop\aeiSB:demo\impl\pnr*\ae358 demo.rpt.txt” completed
Generate file "C:\Users\liukai\Desktop\ae35@ demo\impl\pnriae35@_ demo.tr.html" completed
Mon May 22 11:31:06 2023

<

- " P = F o
Generate file "C:\Users\liukai\Desktop\ae35@_demo\impl\pnr\ae35@8_demo.rpt.html" completed

%

8.8 T#

SUG1031-1.0

Consale  Message

ZEBAR N T HE “Programmer”, T #HGH S0

=IRAE, “Process > Program Device”, 1 :3ZH#. “Tools >
Programmer”, BT HA “I48”, $TH Programmer.

1% $% Programmer 3% #. “Edit > Configure Device”, =T HA*%
“rT, BCE N EGRT, anfE 8-30 Bk

“Access Mode” THi%|#, %&£ “External Flash Mode 5AT”,

“Operation” FHilE, %£# “exFlash Erase, Program 5AT” 5§
“exFlash Erase, Program, Verify 5AT”.,

“Programming Options > File name” &3, 1AL SCAES
“External Flash Options > Device” £, #%# “Generic Flash”.

“External Flash Options > Start Address” &1, % & N
“0x0000007,

® i “Save”, SERL T EILTIACE .
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[# 8-30 FEHIEMALE

¥ Device configuration ? et

Device Operation
hccess Mode: External Flaszh Mode BAT -

Operation: exFlash Erase, Frogram BAT -

exFlazh Eraze, Program GAT

Programming Options

File name: |{Users/liukai/Desktop/2e350_demo/impl/ prr/2e350_demo. E5| I .. |

Uzer Flash Tnitialization

External Flash Options

Terice: Generic Flash -

Start Addrezs: Q000000

Save Cancel

FERC N BRI B Ja, S TR “707, NERLRSCT
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9%%‘1‘&%

RiscV_AE350_SOC i it =2 it

...\ref_design\FPGA_RefDesign\DK_START_GWS5AT138_V2.0\ae350
_demo

...\solution\Extended_AHB_Slave\ref design\FPGA RefDesign\DK_S
TART_GW5AT138_V2.0\ae350_ext_ahb_slave

...\solution\Extended  AHB2AHBBridge\ref design\FPGA RefDesign\
DK_START_GWA5AT138_V2.0\ahb_to_ahb_16_bridge

...\solution\Extended_APB_Slave\ref _design\FPGA_ RefDesign\DK_S
TART_GWS5AT138 V2.0\ae350 ext_apb_slave

...\solution\Extended APB2APBBridge\ref design\FPGA_RefDesign\
DK_START_GWA5AT138_V2.0\apb_to_apb_16_bridge

...\solution\Extended_Interrupts\ref _design\FPGA_RefDesign\DK_STA
RT_GW5AT138_V2.0\ae350_ext_intr

...\solution\Extended_APB_Flash\ref design\FPGA _RefDesign\DK_S
TART_GWb5AT138_V2.0\ae350_ext_flash

...\solution\Extended_Data_Memory\ref design\FPGA _RefDesign\DK
_START_GW5AT138 V2.0\ae350_ext _data_memory
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